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PDF maps are a very handy way to share your information with the public as well as co-
workers. They can also be a way to share more detailed GIS information with people in the field 
without them ‘touching’ the live GIS. This allows people to work with GIS information without 
being forced to purchase expensive software or learning how to use complicated software. 
 
This tutorial explains not only the basics of creating pdf maps but also creating map books or 
atlases and then exporting to pdf simple maps as well as those that allow layers to be turned 
on/off and also attributes. 
 
 
Basics 
 
Using ArcGIS software you can save maps to PDF using File -> Export Map 
 
 

 
 
 
There are many format options to choose from, but for this discussion we’re using pdf 
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It’s always good to make the name simple, but including a year or date is good, especially if you 
plan to update or put on the web.  
 
If you’re going to put a file on the web the smaller the file the better, however, be sure you don’t 
make a file with so low a resolution that it’s pixelated. On the other hand, if you make it high 
resolution it may not be suitable to be on the web. Either way, if you have Adobe Acrobat it’s a 
good idea to use the ‘Reduce File Size’ function, which will do a good job of making the file size 
smaller without ruining the quality of the map  
 
(NB: exceptions being the layer and attribute PDFs) 
 
If you have Adobe Acrobat on your computer you could also create a pdf using the print 
function. Choose File-> Print -> then in the printer choice pick Adobe PDf or Distiller, depending 
on the version you have. You’re then asked for a location and file name to save as. This can be 
used with most any software or documents from the web. 
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Sets of maps, mapbooks, or atlases 
 
From the most basic annual update of Assessor maps to the most imaginative set you can 
come up with, creating a set of maps is pretty simple now if you use DSmapbook, which is 
available as a free download from ESRI. The hyperlink will take you directly to the download  
 
Once you install the application you should have an additional Map Book tab below your Table 
of Contents as shown below 
 
 
 

 
 
 
 
The basic requirement to set up a map series will be a layer to use for the grid (that will be used 
for the template of each page). This grid requires a STRING field to be used to define the page, 
which may also be used to number each page. If you don’t have this field in your attribute table 
then add a field that you format as a STRING and insert the grid names. You should be sure 
you have this layer before you go on.  
 
Hints:  

- if you use numbers then start with 01 instead of 1 or they’ll be listed out of order when 
you export. 

- if your grid (or any other layer) has a cryptic name then rename it in the Table of 
Contents BEFORE you set up the series. This will be more important in future examples 

 
Work in Layout View and set up the page layout first. For maps that will go to a wide audience 
11 x 17 is a good size since they can be shrunk to print on 8.5 x 11 paper and still be detailed 
when printed. But use whatever size you need.  
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Setting up the Series: 
 

1) Click on the Map Book tab. It should look similar to the example below. 
 
 

 
 
  
 2)  Right-click on Map Book and Click Add Map Series 
 

 
 
 
The following window will pop up 
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Notice in the default window that it already picked out my grid layer and the correct STRING 
field.  Also, the index layer lists Map Grid although my layer is actually called assrgrid, because 
I renamed it.  If you rename this afterwards you will get an error in your series…… 
 
If the default information is correct then choose Next. The next window should be defaults 
unless you have a map page that needs removing for some reason 
 

 
 

This next window will allow you to set up the scale as well as a few other options. If they can all 
be the same scale then just enter that in the Fixed Extent. If you have a series that should have 
variable scales you can use the ‘Data driven’ option, which would require you to create a field in 
the grid layer where you’d enter the scale for each grid. 
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Other options exist in this window. Label neighboring tiles can be useful but looks a little messy. 
Try these options yourself. 
 
Click Finish when you have set your scale. Your series should have been created and be listed 
in the Table of Contents. 
 

 
At this point you won’t see any change in the layout window until you double-click one of the 
pages listed on the left. 
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But since no labels were included when this was set up we have no way to know which map this 
is, and we don’t know if the scale will work to make that grid fit this page (which it doesn’t).  So 
we’ll go back and make a couple of changes.  
 
First, click the Display tab and label the Map Grid layer 
 

 
 

Next, go back to the Map Book tab and right-click Map Series and choose Series Properties 
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Click the Options tab and tweak the scale until it works for you. (I’ve chosen this scale because I 
know it works for this example and I don’t need a standard scale) 

 

 
 

Once you have clicked OK, go back to any page in the series and double-click to update it. 
You’ll see you now have the grid showing (in red), so you know that scale works for your page 
size. Using this method (of showing the grid) allows a user to see that they have additional 
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options to view the same parcel (for example) since it will also show on the adjacent maps. In 
many cases this is a good idea. 
 
 

 
 

The above example is pretty plain and also demonstrates potential labeling issues.  
 
Here’s an alternative. You can create a page # that will get picked up by your series. Let’s set 
one up. 
 
Click the New Text option of the Drawing toolbar and click to insert on your map page. 
 
 
 

 
 

With the text still highlighted right-click on Map Series and choose Tag as Page Number 
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The text box changes, and if we turn off the labeling on the Grid layer and then double-click the 
page number to refresh it now gives you the page number. 
 

 
If you look back at that list you’ll see there are several other options you can use with text, 
including the date, which is very handy if you need to keep tabs on revisions. 
 
Another handy tool is on the Map Series toolbar. It’s called the Page Identifier and gives two 
options (I like to use them both) 

 
Once you click OK you need to draw a rectangle on your layout where you’d like this to be. 
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In the Display tab of the Table of Contents you now have an additional data frame. It’s useful to 
add your map outline to this too. After you refresh the page (as before) it will show you where in 
the grid layer you are. Here we show both ‘global’ and ‘local’ after adding the town line. The 
previous page number has been set in the rectangle of the ‘global’ and in the ‘local’ the grid 
numbering has been applied. The local identifier seems to be a much ‘cleaner’ way to label your 
grids and avoids covering information on your actual map. 
 
 

 
 
 

You can make these as simple or as fancy as you like, but I’ve found that in addition to the 
series, creating an Index page that possibly includes a street list (to be used as a cover) is very 
handy and the ‘clickable’ section will explain further. Incidentally, you can export the series 
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index (in this case a street index listing) automatically from Map Book. It creates a text file that 
shows all grids the street appears in.  
 

 
 
I then copy sections of the list back onto the index page to where I want it using whatever font 
and size I want. It’s nice to then make this clickable. One other thing that came back to me as a 
suggestion was to create a separate ‘large font’ (regular size) listing (using the same text file) 
that I add to the back of the atlas for those who can’t read the font on the index page.  
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To export your map series simply right-click on Map series and click Export Series  
 

           
 
change the jpeg to pdf and set the resolution appropriately. 
 
Create a folder to place the maps and for name just simply ‘map’ or ‘page’ then Save and OK 
 

 
 
The maps will be given the prefix of the name you gave followed by the name in the STRING 
field. The window will close after all maps are exported. 
 
The maps can be combined into a single pdf file if desired by using Adobe Acrobat 
 
 
Creating maps with layers 
 
This can be done as simple maps or as map series and can only be done if you have ArcGIS 
9.2 or newer. In 9.2 this happens by default when you export your pdf files they will have the 
layers available. At 9.3 you have the option to export with or without layers (see below). If you 
decide you don’t want the layers available you can use Adobe Acrobat and use the Reduce File 
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Size option. This will ‘flatten’ the map and remove the ability to see separate layers. We’ll 
discuss the Export PDF Layers and Feature attributes later 
 

 
 

One of the challenges with the layer versions is that some of the layers may be combined so 
that the separate layers aren’t available. This can usually be resolved by rearranging the layer 
‘stack’ on the ArcGIS side of things. This sometimes takes a few attempts but usually worth the 
effort. 
 
Renaming cryptic layers in the Table of Contents will save you a lot of extra work as was done 
with the following map 
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The file is then viewed using FREE Adobe Reader (this is version 9) that can be downloaded 
from Adobe.com 
 

  
 

The red arrow shown (above left) indicates that there are layers in this pdf, and by clicking this 
icon you can see what they are (sometimes a ‘+’ needs to be opened). The list of Layers is 
almost identical to the list in the ArcGIS layout. By clicking on the eye shown by the arrow 
(above right) layers may be turned on/off. This can then be used to control printing 
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With some layers turned off we have then zoomed into a smaller area. In the Print window we 
then set the properties so that we can print just a small portion of our map with only those layers 
we chose and set to fill a letter-sized page. We could then go back and turn on/off other layers 
using the same extent and print again for comparison. 
 

 
 
 
 
 
 
 

Lynne Fielding, GISP Page 16 6/18/2009 



PDF maps & atlases from ArcGIS 

Layers & atlases 
 
Let’s consider doing the same process in a multi-page atlas. The example below shows that the 
‘selected page’ layers are listed in bold at the left.  
 

 
 
An alternative would be to only display the layers for the visible page, which would be easier to 
keep track of. 
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Turning layers on/off works the same but you need to be a bit more careful in setting up the 
printing of a selection from one page. 
 

 
 

Again being sure to check the Current View / Current page rather than All 
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PDFs with GIS attributes 
 
The ability to export GIS attributes came with ArcGIS 9.3 but you should go to ESRI and 
download the PDF patch: 
 
http://support.esri.com/index.cfm?fa=downloads.patchesServicePacks.viewPatch&PID=66&Met
aID=1407 
 

 
 
You also need to download Adobe Reader 9 (FREE) 
 
Once you have the patch installed you can do more than just export attributes with your pdf, but 
read ESRIs page for that. 
 
First we’ll go with our simple one-page layout we had before. We won’t change anything else on 
the ArcGIS side and see what happens 
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The same layer information is there and nothing else has changed that we can tell. 
 
We need a new toolbar in Adobe Reader. The Analysis toolbar 
 

 
 
This toolbar (as shown below) allows you to get information that has been exported with the 
PDF. The other tool allows you to get lat-long info but that’s not the current topic…… 
 
 

 
 
If I click on this tool and then click on the parcels this is what happens…… 
 
I’ve opened the + in front of Layers, in the next step I’ll open one of the actual layers 
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Everything appears to be selected (in red) and a Model Tree window has opened at the left. 
 
Below I’ve clicked open Bldg Footprint then clicked on any one of them.  
 
In the bottom window all the attributes I allowed to be exported are available for ANYONE to 
see. Obviously this is more data than I want out there. In addition, from the way the addresses 
are shown in the list I have no way of telling what the address is until I click one.  
 
We need to fix these things in ArcGIS 
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ESRI recommends you only allow attributes from ONE layer to be exported…… let’s at least do 
two, but we’ll turn some fields off that aren’t useful. 
 
First we’ll deal with parcels. We use the Primary Display field to set what’s shown in that first 
list. Then we uncheck all fields we don’t want data available for. Even the field names won’t 
show in the pdf when we’ve finished. Here’s what it looks like after…… 
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Much easier to find and more relevant information shown. 
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Let’s change parcels. We’ve set their primary field to the LOTID (parcel ID) so that it’s not the 
same as the buildings. 
 

 
 

Notice the selected parcel is highlighted using the color shown above the list. By right-clicking 
you can also elect to zoom to that parcel. Below left are the attributes ‘allowed’ from the GIS 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lynne Fielding, GISP Page 24 6/18/2009 



PDF maps & atlases from ArcGIS 

Setting up the clickable bits in Adobe Acrobat 
 
You’ll need to have Adobe Acrobat to do this (although there may be other products out there 
that can do it). Versions as old as 6.0 can create the clickable links. 
 
A few things to remember before you set up any clickable ‘products’ 
 

1) If this is going to be a product you reuse or update, then make sure the layout works for 
you. The ones I currently use are the result of trial and error. 

2) Consider the layout size (if a map).  
3) Consider the file size (especially if you want to put this on the web) 
4) For web products keep it self-contained 
5) If larger files (as with layer &/or attribute maps) keep separate 
6) If you’re linking several external files put them in folder(s) at the same level as 

your pdf. Links are relative and this will make the final product easier to share. 
 
 
How to create basic (internal) links 
 
First I’ll use examples that make an assessor ‘atlas’ easier for everyone to use. 
 
I have created an ‘Index page’ that shows the entire town, the assessor map grid and all the 
streets. This has been combined into a single pdf. The figure below shows how this looks if I 
turn on the page thumbnails while displaying the Index page. 
 

 
 
This atlas already has the ‘clickable’ bits set up. You can set the links with a visible/invisble box. 
I’ve set these to be invisible. On this page each street name and each grid box is set as a link. 
The street name will take you to the first page listed for that street zoomed to the best extent of 
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that street. To see the links you need to turn on the Advanced Editing toolbar. This may look 
different in your version but the tool is similar. 
 

 
 

Here I’ve ‘undocked’ the toolbar and selected the linking tool (looks like a chain), which now 
reveals the items that have links on this page. 
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You can tell when something has a link by using the hand tool     
 
When you hold the hand tool over the pdf it changes to a pointer if it’s ‘clickable’ (there’s a link). 
 
On the other pages in this atlas the ‘clickable’ parts are on the local and global indicators, which 
you remember we set up earlier. On all pages the global link takes you back to the Index page. 
The ‘local’ links have been set up so that there is a link on each numbered box so that you can 
click any numbered box to go to that page. These are the adjacent maps to the ‘current’ one. 
 
 

 
 

When updating the series then I change the date, color of banners and maybe local indicator 
background so it appears slightly different, but then when pages are replaced the ‘clickable’ bits 
are already there so it’s minimal work. 
 
So how do we set a new link? 
 
We’ll redo one of the global links that take you back to the Index page. 
 
Click on the link tool   (chain).  When you move over the pdf you now see cross-hairs. Use these 
to draw a box where you want to make a link. After you’ve drawn the box the following window 
pops up. For this we want to ‘Go to a page view’ and make the box invisible. Click Next 
 

 
 

The next step is to choose the page (or extent) you want to link to. 
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Don’t click the Set Link until you change to the location or view you want. In this case we want 
the Index page. We can use the thumbnail to get that page and in this case we want the full 
page so we’ll zoom back out to that view (I keep that icon and several other useful ones on the 
toolbar) 
 

 
 
As soon as you click the Set Link it will return to the page where you were setting the link. With 
the link tool still active you notice the link box has changed from solid color to just the handles 
having color.  
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Change to the hand tool and test your link. It’ll be easier to return to the link page if you have the 

Previous button on your toolbar.    This and other buttons can be set out using Tools -> 
Customize  
 
 

 
 

 
In the previous example, if you’d wanted to show just part of the page (as in a single street) you 
would zoom in to that area before you click the Set Link 
 
Similarly, if you wanted to link to a file or a web page you can set those links the same way. 
Again, if you have many files you want to link it’s better to have them contained in a folder or 
folders, especially if you intend to share them. 


